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Copyright Information

All rights reserved. No part of this publication may be reproduced, transmitted, stored in a
retrieval system, or translated into any language in any form by any means, mechanical,
optical, electronic, recording, or otherwise, without the written permission of Mustek,

Incorporated.

Mustek Incorporated reserves the right to revise this manuaj and to make changes to any or
all parts at any time, without abligation to notify any person or entity of such revisions and

changes.

Mustek is a registered trademark of Mustek, Incorporated. All other brand or product names
mentioned in this manual are trademarks or registered trademarks of their respective

~QWNETS,

Copyright © 1998 Mustek, Incorporated.
Printed in Taiwan, June 1993.

FCC Statement

This digital equipment has been tested and found to comply with the limits for a Class B

digital device, pursuant to Part 15 of the FCC Ruies. These limits are designed to provide

reasonable protection against harmful interference when the equipment is operated in a .
residential installation. This equipment generates, uses, and can radiate radio frequency —@—
energy and if it is not installed and used according to the instruction manuai, it may cause

harmful interference to radio commurications. However, there is no guarantee that

interference will not occur in a particular installation. If this equipment causes harmful

interference to radio o television reception, which can be determined by turning the

equipment off or on, you are encouraged to try to correct the interference by one or more of

the following measures:
+  Reorient the receiving antenna
. Increase the distance between the equipment and the receiver

. Connect the equipment into an outleton a circuit different from that to which the
receiver is connected

. Consult the dealer or an experienced radio/TV technician for help

NOTE

1. The changes or modifications not expressly approved by the party responsibie for
compliance could void the user's authority to operate the equipment.

2. Shielded interface cables and AC power cord, if any, must be used in order to comply

with the emission limits. v

.
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Hardware Installation

This chapter covers the scanner parts and describes how to connect the
scanner to your computer. It also describes the procedures to install the
scanner driver and the included software.

Unpacking the Scanner

Carefully unpack the contents of the scanner package and inspect the items
for damage that may have occurred during shipping. If damage is found
please contact your dealer immediately.
' This scanner package should contain the following:
. * 1200 CPscanner
* Scanner connection cable
« Power adapter
« Installation CD
+ User manuals

The Scanner Parts
Please familiarize yourself with the parts of the scanner prior to use.

The Flatbed Scanner (Back)

Insn_zllariau 5



Minimum System Requirements

+  IBM PC/486 or compatible, running Microsoft Windows 3.1x/95/NT
»  Super VGA color monitor

=  CD-ROM drive

+  ZMBRAM(Win3.1x)

+ 16 MBRAM(Win 95/NT)

Connecting the Scanner to the PC and Printer

Refer to the following illustration and steps to install your scanner.

\_'__// ’

: (gl;%

1. Power off the computer and any devices that are connected to it
(e.g., monitor, printer, modem).
2. Disconnect the printer cable from the printer port in the back of your PC.

3. Take the disconnected end of the printer cable and attach it to the
port in the back of the scanner for the Printer. Tighten the retaining

SCTEWS,

4. Connect one end of the scanner cable to the printer port in the back of
your PC and tighten the retaining screws.

5. Connect the other end of the scanner cable to the port in the back of
the scanner for the Computer.

6. Connect the power adapter to the scanner and plug it into an
appropriate power outlet.

7. Power on the computer and wait for the computer to finish booting.

Install the scanner driver and software by referring to the next section.

6 CIS Scanner User’s Guide
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Software Installation

Installing the TWAIN Data Source

Windows 95/NT Route

Begin by inserting the
Mustek 1200 CP CD.

Follow all on-screen instructions.

Note: If your Autorun feature is
disabled please refer to the following
instructions.

Click on “Start”
and select “Run”.

WindostS

In the “Run” dialog box, type
“drive:\run” where drive is your
CD-ROM drive and click “OK.”

Follow ail on-screen instructions.

Windows 3.1x Route

Begin by inserting the
Mustek 1200 CP CD.

®| From the Program
B Manager, click on
! the “File” menu

and select “Run”.

In the “Run” dialog box, type
“drive:\run” where drive is your
CD-ROM drive and click “OK.”

Follow all on-screen instructions.

L

Installation

_\l
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Scanning Tutorial

-

This chapter covers the two separate methods to scan an image: the
Scan Dialog box, which is ideal for quick and simple scans ard the
TWAIN Dialog box, which offers more control over the scanned
output.

This chapter details:

1. Using the Scan Dialog Box

2. Using the TWAIN Dialog Box
3. Performing a Simple Scan

4, Positioning a Document

5. Scanning Tips

OUsing the Scam Dialog Box

)

—=1

ifo-

You can access the Scan Dialog box in the following two ways:
1. The Direct Scan Icon: Double-click the Direct Scan icon, located in

your Windows taskbar.

2. From the Program group: Click on the Scan Dialog box icon, located
under the Start menw/Programs/

3. The Cover Sensor Dialog Box: This scanner is equipped witha
Cover Sensor feature that takes you directly into scanner access mode.
Simply lift the cover of your scanner and the Cover Sensor dialog box
will appear. To proceed to the Scan Dialog box, click "Continue".

This Cover Sensor dialog box can be disabled by selecting the
disable feature. By doing this the Cover Sensor takes you directly
to the Scan Dialog box. To re-enable the Cover Sensor dialog box
right-click the Direct Scan icon [ocated in your Windows Notifica-
tion Bar. A pop-up menu appears allowing you to re-enable the
Cover Sensor dialog box as well as disable or re-enable the Cover

Sensor feature. I

Secanning Tutorial 9
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The Scan Dialog Box

The Scan Dialog box is multi-function software that allows you to perform
several functions using your scanner {e.g. scan, copy, fax). Simply select the
function that you wish to use by clicking on the appropriate page icon and
the corresponding menu page wili appear.

Scan

Scan [con —@
_ Copy Icon ——E
Fax Icon ———@
E-Mail Icon ———@
OCRIcon —— Qs |

|

Scan
Scan the image Lo iha compufer.

Help

—-— About

Menu Page Browse Icon

_ Scan Page:
@ Scans the image or document into the computer.

Copy Page:
Uses your printer to Copy the image or document.

Fax Page:
Uses your modem to Fax your scanned image or document.

E-Mail Page:
Uses your modem to ¢-mail your scanned image or document across
the Internet

OCRPage:
Launches the OCR application to convert the scanned document into
ready-to-edit text files. ’

10 CIS Scanner User's Guide
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Scan:
Executes the scan function for the Menu Page that you arecurrently

mn.

Scans the image/document into the image editing software in the Scan
Page.

Copies your image or document to your printer in Copy Page.

Faxes your image or document through your modem in Fax Page.
E-mails your image or document to the Internet in E-mail Page.

Scans the document for editing into your OCR software in OCR Page.

Exit:
Exits the program.

Help:
Offers available on-line help for all of the scanner and software
functions.

About:
Shows product information.

The Browse Icon: This icon allows you to select the software
application you would like to open the scanned image into.

Secanning Tutorial 1



Menu Pages

Scan Page:

Scan an image or document to the computer via any image editing
software.

Use the Browse icon to select the image-
editing software from your computer. iPhoto
Plus is automatically installed as your default
software

(.. IPPLUS.EXE).

Click the Scan icon to begin scanning!

Copy Page:

Copy an image or document to your printer.

Use the Print icon to setup your printer.

Click the Scan icon to begin copying!

Fax Page:

Scan and fax an image or document via your fax modem.

Use the Print icon to setup your printer (Fax
driver).

Click the Scan icon to begin faxing!

12 CIS Scanner User's Guide
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E-Mail Page:

Scan and send an image or document to the Internet using your SMTP
address/account.

Enter your SMTP address, the destination address {To:),

b and your full address (From:).
o : EETICIRIEST O : - :
(For SMTP details, contact your Internet Service Provider)

73

e ¥ Joaial RiEzample. com

T

[Eowa; R Example

Daar Joa. B

OCR Page:

Clicking the Mailing icon opens the Mailbox,
which allows you to type an attachment.

Clicking the To: button opens the Address bobk,
which allows you to store addresses and add
additional destination addresses to your e-mail.

Click the Sean icen to begin sending ydur
information across the Internet!

Uses TextBridge Classic to convert an image document into a text file.

Ciick the Sean icon to execute the OCR function!

TextBridge will automatically open showing an image thumbnail of the
scanned document. Save the document as desired, then open the
document using your word processing software.

Scanning Tutorial 13
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9 Using the TWAIN Dialog Box

14

TWAIN is the industry standard that allows the scanner to
communicate with the computer. You can access the TWAIN Dialog
box from within any TWAIN-compliant software such as the
application software included with the scanner.

To access/launch the TWAIN Dialog box:

1. Launch Windows.

7 Launch the TWAIN-compliant program (¢.g. iPhoto Plus 1.2 or
4.0).

3 Under the File menu open the Acquire command and choose
Select Source. The Select Source dialog box appears.
Note: In some image editing software you may choose Select
Source directly from the Select Source command rather than the
Acquire command.

Sources:

4. Choose your scanner from the list (if there isonly one source
available, it is automatically selected).

5. Click the Select button. The Select Source dialog box closes.

6. Retum to the File menu. Locate and click the Acquire command.
The Acquire command is likely to be found beside the Select

cormmand.
The TWAIN Dialog box appears.

CIS Scanner User's Guide
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The TWAIN Dialog Box Controls

Batch Scan Button
Allows creation of up to 10
scan regions {or Crop
Frames) for multiple

The Cropping Tool
Allows you to retum
to single scanning mode
after using Batch Scan.

scanning.

Menu Tabs
Contain the
various settings
used for
scanning.

Scanner
Controls

Descreen Button
Reduces image noise
or patterns.

Preview
Window

Zoom Buttons
Magnifies or shrinks
the image in the
Preview Window.

Help
Activates the on-
line help system

Language
Changes the language

Exit
Exits the program

Prescan Button
Produces a low-
resolution copy of the
i b
image on the scanner. S

i
Scan Button
Executes the scan
command.

Crop Frame

Outlines the image area or region
that will be included in the final
scan.

The TWAIN Dialog box consists of two sections - the Menu Tab
section (left) where most of the control settings are found, and the
Preview window section (right) which contains the the command and

viewing controls.

Scanning Tutorial 15



o Performing a Simple Scan

16

The steps to follow when scanning are:
1. Select the scan size,
Select the desired scan mode.

Select the desired resolution.

2

3.

4. Prescan the image.

5. Use the crop frame to set the exact area to be scanned.
6.

Click the Scan butten.

These steps are explained in detail in the following sections.

Seléct the Scan Size

From the list of available paper sizes, select the size of the document
you wish to scan. Custom will automatically be selected when you use
the Crop Frame to change the image area to be scanned.

Select the Scan Mode

The Scan Mode determines how the scanner will read the image.
Select Color to capture images in color. Select Gray to capture images
in shades of gray. When you wish to scan line art or text for OCR
(Optical Character Recognition), select LineArt.

Select the Resolution

The Resolution, which is measured in dots per inch (dpi) determines
the effect of the image as it is displayed or printed. Images scanned at
a high resolution capture more information but require more time to
scan and more disk space for storage. A variety of preset resolutions
are available to choose from.

CIS Scanner User's Guide’
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Prescan the Image

This low-resolution scan of the entire original image allows you to get
a clearer idea of the image area you want to include in the final Scan.

To prescan:
1. Place the document face down on the scan window glass.

2. Click the Prescan button. After the scanner has scanned the
document, the scanned image will appear in the Preview Window.

From the Prescan image, you can now set the exact image area you
wish to include in your final scan.

Set'the Image Size

Use the Crop Frame in the Preview Window to outline the exact image
area you wish to scan, Click one of the sides or corners of the Crop
Frame and drag it to the desired height and width. To move the entire
Crop Frame, position the mouse cursor inside it and drag it while
pressing the (left) mouse button. Only the area inside the Crop Frame
will be included in the resulting scanned image when you click the
Scan button.

Use the Zoom Tools

The Zoom Tool increases/decreases the magnification of the image in
the preview window. By magnifying the image in the preview window,
you can more accurately resize the Crop Frame, getting the exact
dimensions of the area you want to scan.

Scan the Image

Click the scan button once you are satisfied with the image area to be
scanned, and once all of the control/enhancement settings have been
applied.

Note: To further adjust your image before scanning see Chapter 3
(The TWAIN Dialog Box) for enhancement and filter details.

Scanning Tutorial 17




ePositioning a Document

For the best possible image scans, it is important that you position
your documents correctly and carefully.

i3

1

2

Lift the document cover.

Place the document face down on the glass and in the upper right
comer where the alignment marks are located.

Stowly lower the document cover, making sure the docurnent
remains in position.

In your scanning program, set up the scanning parameters such
as scan mode and resolution.

Execute the scan command (click the Scan button).

Remove the document after scanning is complete.

Note: ALWAYS SCAN WITH THE SCANNER LID DOWN!

CIS Scanner User's Guide



e Scanning Tips
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The following tables provide helpful information when setting the

scan mode and/or resolution. Recommended scanning resolutions for
various output devices are listed as follows:

PRINTER INPUT SUGGESTED
TYPE MATERIAL [SCAN MODE RESOLUTION
600-dpi Color Grayscale 150 dpi
Laser or Grayscale Grayscale 150 dpi
Inkjet Printer] Line Art/Text| Line Art/Text 600 dpi
300-dpi Color Grayscale 100 dpi
Laser or Grayscale Grayscale 100 dpi
Inkjet Printer] Line Art/Text| Line Art/Text 300 dpi
Check with
Color Inkjet Color Color manufacturer for
Printer Grayscale Grayscale recommended
Line Art/Text | Line Art/Text .
resolution
l?ye . Coler Color Scan at m_axmlum
Sublimation resolution of
or Color Grayscale Grayscale printer in all
Laser Printer Line Art/Text | Line Art'Text modes
Space requirements for different scan modes:
Scan Size 4" X 6" Ad
Resolution
DPI 100 | 300 | 600 | 100 | 300 | 600
703 | 62 | 247 |28 | 249 |o9s
COLCR KB |mMB | MB | mMB | MB | MB
234 | 24 8.2 [944 | 83 | 332
GRAY Ke | mB | MB | KB | MB | MB
293| 284 | 14 |18 11 | 42
LINE ART ke | ke | M8 | kKB | MB | MB

Scanning Tutorial
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The TWAIN Dialog Box

The TWAIN Dialog box is part of the scanning module provided with your
scanner. TWAIN is an industry standard that allows scanning directly mnto
any TWAIN-compliant software. It eliminates most compatibility problems

associated with software and input devices supplied by different vendors.

You can access the TWAIN Dialog box from within any TWAIN-compliant
software such as the application software included with the scanner (e.g.
iPhoto Plus 4.0). If you are not continuing from the “Scanning Tutorial”
please refer to Chapter 2 “Using the TWAIN Dialog Box” before proceeding.

—e;j’}i—

To access the Main, Enhance, Filter or About tabs, simply click on the
appropriate color-coded menu tab.

The TWAIN Dialog Box 21
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Scan Button
Click the Scan button to execute the scan command. A status bar

displays the progress of the image transfer. Once scanning is
complete, the image will be displayed in the main screen of the
host software behind the TWAIN Dialog box. This provides the
option of doing additional scans without re-acquiring the TWAIN
Dialog box each time. To access your scanned image, close or
minimize the TWAIN Dialog box.

Cropping Tool Button
This button allows you to return to single scan mode after you
have used the Batch scan function.

Batch Scan Button

Clicking on this button allows you to have multiple scans on any
part of your document using different control settings. A dialog
box opens. For more details, please refer to the section, Using
Baich Scan found later in this chapter.

Zoom Tools

The Zoom Tool increases/decreases the magnification of the image
in the preview window. By magnifying the image in the preview
window, you can more accurately resize the Crop Frame, getting
the exact dimensions of the area you want to scail.
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Scan Button
Click the Scan button to execute the scan command. A status bar

displays the progress of the image transfer. Once scanning is
complete, the image will be displayed in the main screen of the
host software behind the TWAIN Dialog box. This provides the
option of doing additional scans without re-acquiring the TWAIN
Dialog box each time. To access your scanned image, close or
minimize the TWAIN Dialog box.

Cropping Tool Button
This button allows you to return to single scan mode after you
have used the Batch scan function.

Batch Scan Button

Clicking on this button allows you to have multiple scans on any
part of your document using different control settings. A dialog
box opens. For more details, please refer to the section, Using
Batch Scan found later in this chapter.

Zoom Tools

The Zoom Tool increases/decreases the magnification of the image
in the preview window. By magnifying the image in the preview
window, you can more accurately resize the Crop Frame, getting
the exact dimensions of the area you want to scan.

The TWAIN Dialog Box 23
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The Image Setting Buttons

The Image Setting Buttons are found at the bottom of each tab/folder in the
TWAIN Dialog box and allow you manage the individual settings you use for
scanning. These buttons are especially useful if you use particular settings on a
regular basis, or if you switch between commonly used settings during a single
scanning session.

Load Button

Allows you to load previously saved
settings,

These files are stored as .INI files.

Save Button
Saves the current image settings from all
of the TWAIN tabs, to a specified file

name and location (saved as an .INI file).

Previous Button
Reloads the last saved tmage settings.

Reset Button

Returns the image settings to their default values.

Information Button

Displays the current control settings from all

the TWAIN tabs.

CIS Scanner User's Guide
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The TWAIN Control Settings
The Main Tab

The Main Tab contains the
control settings that are used to
execute a scanm, such as scan
mode, scan source, resolution,
etc. These settings will determine
how the original image or docu-
ment will be scanned, displayed
or printed.

Scan Mode n
The Scan Mode determines how the scanner reads the original image ﬂ‘?;—
or document. When cheoosing a scan made, it is recommended to

consider for what purpose the resuiting scanned image will be used

for.

* LineArt
Use this mode to scan text documents for use in OCR software or
when you wish to scan black-and-white drawings.

* Gray
Select Gray to capture images in shades of gray. Our Gray mode
generates [0-bit (1024 shades of gray) internal images and 8-bit
{256 shades of gray) external images.

« Color
Select Color to capture images in colors. Qur Color mode generates
30-bit (1.074 billion colors) internal images and 24-bit (16.7 million
colors) external images.

Note: Internal images refer to images that are originally captured by
the scanner. External images refer to images that are transferred to the
computer, .

The TWAILX Dialog Box 25
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Scan Source
The Scan Source setting is used to select the type of document you will
be scanning.
*  Reflective
Use Reflective when you wish to scan a paper-based document such
as photographs or text,

Sean Size

From the list of available paper sizes, select the size of the document you
wish to scan. Custom will automatically be selected when you use the
Crop Frame io change the image area to be scanned.

Resolution

The Resolution, which is measured in dots per inch (dpi) determines the’
effect of the image as it is displayed or printed. Images scanned at a high
resolution capture more information but require more time to scan and
more disk space for storage. A variety of preset resolutions are available
to choose from.

100 dpi

Output Scaling

Output scaling allows you to enlarge the size of the image as it is output-
ted to the printer or monitor. For example, setting the Qutput Scaling to
200% doubles the number of pixels present in the image.

‘Width and Height

The Width and Height values are the dimensions of the crop frame on the
image that is displayed in the preview window. These values can be
displayed in either centimeters or inches, and are cross-referenced by the
horizontal and vertical rulers running along the sides of the preview

window.

CIS Scanner User's Guide
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The Enhance Tab

The Enhance Tab contains pre-
scanning effects that can be
applied to the image prior to
making the final scan. Several
effects can be applied to the pre-
scanned image then previewed
before the final scan is executed.
Changes made to the control
settings will appear in the sample
thumbnail.

Image Size

Image Size displays the amount of computer memory required to
display/save the image outlined by the crop frame in the preview
window. The Image Size information is automatically updated
everytime you change any of the control settings or resize the crop
frame.

Descreen
Descreen 1s a useful tool for reducing moiré patterns in scanned
images of originals that were created by a halftone process. Moiré

patterns appear as unsightly interference patterns.

Image Thumbnails

{mage thumbnails are small representations of the image outlined by
the crop frame in the preview window.

To change what appears in the image thumbnails, drag the crop frame
to a different location in the preview window, or drag the edges of the
crop frame to change its dimensions.

Histogram

The Histogram graph shows the distribution of brightness levels in an
image. Using the control settings {Brightness, Contrast, Gamma) you
can selectively adjust the brightness levels in the shadows, midtones
and the highlights of the image. ‘

The TWAIN Dialog Box 27
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» Histogram Button

The Histogram Button allows you to view the histogram as either a
line graph or a bar graph and adjust its viewing levels. The
horizontal axis represents the brightness levels from darkest (left)
to brightest (right}. The vertical axis represents the amount of pixels
with that brightness level value.

Channel Selector

Channel refers to the red, green, and blue layers that make up a
color image. You can choose to change the channels individually
or choose Master to change all the channels equally and
simultanecusly. An image in Gray Mode has only one channel.

Brightness Control

Using 255 steps, this tool allows you to adjust the overall amount
oflight in the image. A value of -127 will make the image appear
very dark, whereas, a value of +127 will make the image appear
very bright.

Brighmess -30 Brightness ( Brightness 50

Contrast Control .
Using 255 steps, this tool controls the disparity in tone between
the dark and light areas of an image. Positive values create greater
differences between dark and light areas of the image, whereas,
negative values create greater similarities between the dark and
light areas of the image.

Contrast -50 Contrast Conl:asr 30

28 CIS Scanner User’s Guide
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Gamma Control

The Gamma control is used for adjusting the brightness level in
the highlights, mid-tones, and shadows of the image. Values of 0.1
to 2.0 primanly affect the shadow areas of the image. Values of 2.1
to 6.0 primarily affect the midtone areas, and values of 6.1 to 7.9
primarily affect the highlight areas.

For Example: A gamma value of 1.9 will make the shadows of an
image appear brighter, whereas, a value of 0.2 would darken these
shadow areas (taking away brightness).

A gamma value of 7.8 will add light to the highlight areas of the
image (making the image appear bright), whereas, a value of 6.4
would subtract light from these highlight areas.

Gamma 0.6 Gamma [.5

Preview Button

Click the Preview button to see any enhancement effects/changes
applied to the image . The changes will appear in the Preview
window image.

Note: The effects/changes applied to the image as displayed in the
preview window will only be applied 1o the image after you have
clicked the Scan button and the scan command is executed.

The TWAIN Dialog Box 29
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The Filters Tab

The Filters Tab contains pre-
scanning controls that allow
you to apply special effects to
the image before making your
final scan. Any filter applied
will immediately show its effect
in the sample thumbmnail.

* None
This is the default setting, signifying that no filter has been
applied.

+ Blur

The Blur filter smoothes the image by lightening the pixels that are
in sharp contrast to their neighboring pixels. Use the +/- buttons
to increase/decrease the amount of the filter applied.

» Sharpen
The Sharpen filter enhances the detail in blurry images by
tmproving the focus and increasing the contrast in the image. Use
the +/- buttons to increase/decrease the amount of the filter
applied.

* Invert
The Invert filter reverses an image to its negative or compliment.
L] F]jp
The Flip filter creates a mirror image of the original by flipping the
image horizontatly.

CIS Scanner User's Guide
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» Emboss
The Emboss filter makes the elements in an image appear raised
or surken.

*  Unsharp Mask
The Unsharp Mask filter detects sharp edges and color
boundaries and then emphasizes them.

The About Tab

The About Tab contains the current driver version number and the’
copyright notice.

The TWAIN Dialog Box

R
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Using Batch Scan

Batch scanning is an easy
way to muiti-scan any part a
document using different scan
modes and resolutions
(however, certain application
programs do not support this
function). You can specify up
to a maximum of 10 scan
regions or you can scan a
single region several times

- using different combinations
of scan modes and resolu-
tions.

To use batch scan:

1. Click on the Batch Scan button. The Batch Scan dialog box
appears.

2. Create a scan region:
(a) Move the cursor inside the preview window.

(b) Hold down the Shift key, press the left mouse button and drag
the mouse to create a crop frame.

& ‘)}

(¢) Reposition or resize the crop frame if necessary.

3. Set the desired scan mode and resolution for the current scan
region.

4, Repeatsteps 2 and 3 if you wish to create more scan regions. You
can have up to 10 scan regions.

5. Click Scan. The scanner will begin to scan the scan regions one
after the other.
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Appendix A:

Scanner Type
Scan Modes

ScanMethod

~Scan Area

Resolution

Scanning Data Buffer

Brightness Control

Contrast Control
—“o Interface

Dimensions

Weight

Voltage Requirements
Power

Operating Temperature
Operating Humidity
Storage Temperature

Storage Humidity

Specifications*

Flatbed

True Color: 30bits (internal), 1.074 billion colors
24 bits (external), 16.7 million colors

Gray Mode: 10 bits (internal), 1024 shades of gray
8 bits (external}, 256 shades of gray

Text/Line Art: 1 bit/pixel(2 levels)

Single pass

8.5"x11.7"(2 16x292mm}

Optical: 600 dpi(H)x 600 dpi (V)

Maximum: 19,200dpi x 19,200 dpi(throughsoftware interpolation)

32KB{maximum)

255 adjustable steps (software controlled)

255 adjustable steps (software controlled)

EPP

16.4"x11.1"x 2.5"(Lx W x H)

416mmx 282 mmx 64mm(LxWxH)

5.11bs(2.3kg)

ACI00V~120V or200V~240V,47~63 Hz Adapter

12V DC input

10 to 40 degrees Centigrade (50 to 104 degrees Fahrenheit)

20% to 30% RH, noncondensing

-10 to 60 degrees Centigrade (14 to 140 degrees Fahrenheit)

20% to 80% RH, noncondensing

— nl 1
DRk, Tas g2 1 =

* Product specifications are subject to change without notice.
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Appendix B: Technical Support

Mustek, Inc, Mustek Computer GMBH Mustek Systems, Inc.
121 Waterworks Way, Suite #100  Hellersbergstr. 2a No. 25 R&D Road 2
[rvine, CA 92618 41460 Neuss Science-Based [nd’l Park
USA Germany Hsinchu, Taiwan, R.0O.C.
TEL: 1-94%9-788-3600 TEL: 49-2131-162840 TEL: 886-3-5779373
FAX: 1-949-788-3670 FAX: 49-2131-103830 FAX: 886-3-5784139
24-hour BBS 949-788-3630 BBS:49-2131-167104 http://www.mustek.com.tw
http://www.mustek.com BB5:49-2131-130052

http://www mustek-europe.com

To bring you the best possible service, please have the following information ready

»

-when you call:

Which scanner model do you have?

Which computer mode! are you using?

What version of scanning software do you have?

What other application programs are you using?

What other components are in your system? {For example, FAX card, sound
card, SCSI card and so on.)

What are the problems/symptoms you encounter?

Product Repairs

For Product repairs please follow these steps:

L

Call the technical support department for a Return Material Authorization
{RMA) number and refer to this number in all future cails.

2. Consult your dealer regarding proper repair procedure,

3. Forrepairs being shipped to the manufacturer, please write the RMA number
clearly on the outside of the package and send it postage paid, prepared and
packaged appropriately for safe shipment,

Product Returns

= Users must return the products to their point of purchase for a refund or credit,
according to the dealer's policy.
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